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Introduction 

 

Excel is a program in the Microsoft Office system that allows easy 

entry and manipulation of figures, equations, and text. Excel can be used to 

create and format workbooks (a collection of spreadsheets) in order to 

analyze data and make more informed business decisions. Specifically, 

Excel helps  

– to track data,  

– build models for analyzing data,  

– write formulas to perform calculations on that data,  

– pivot the data in numerous ways, and  

– present data in a variety of professional looking charts. 

Common scenarios for using Excel include: accounting; budgeting; 

billing and sales; reporting; planning; tracking; using calendars. 

The Excel spreadsheets are generally used by many researchers for 

engineering calculations, as they can enter initial data in the table format 

and then evaluate them using arithmetical and build-in statistical functions. 

The Solver add-in in Excel provides the possibility to solve the problems of 

non-linear equations and optimizations. Results from the spreadsheets are 

readily plotted and procedural language (Visual Basic for Applications) can 

be used for more complex tasks. 

The present teaching and practical guide observes 9 subjects 

connected to engineering calculations in Excel for chemical engineering. 

Subject 1 and Subject 2 describe the ways of basic arithmetic calculations 

in Excel using built-in functions. The logical functions and their usage are 

given in Subject 3. The 4
th

 subject examines the possibility of plotting the 

data. The main approaches for working with tables are listed in Subject 5. 

Subjects 6 – 9 are devoted to more complex mathematical problems, such 

as solving the systems of equations, finding the local minimum and 

maximum of functions and approximation of the experimental data. Each 

section contains the example with the detailed step-by-step explanation of 

the required action to solve the problem and corresponding illustrations. 

The number of tasks for individual work is provided for each subject.   
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Subject 1. GETTING STARTED WITH EXCEL 

 

1.1. Create a new workbook 

1. Click the File tab and then click New (Figure 1.1a).  

2. Under Available Templates, click Blank Workbook (Figure 1.1b). 

3. Click Create. The new Excel document presented in Figure 1.2 

will appear. 

 

 

 

a 
b 

 

Figure 1.1 – Creating new document 

 

 
 

Figure 1.2 – The new Excel document 
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1.2. Working with worksheets 

To insert a new worksheet do the following: 

1. To quickly insert a new worksheet at the end of the existing 

worksheets, click the Insert Worksheet tab at the bottom of the screen 

(Figure 1.3). 

2. To insert a new worksheet in front of an existing worksheet, select 

that worksheet and then, on the Home tab, in the Cells group, click Insert, 

and then click Insert Sheet. 

 

 
 

Figure 1.3 – The Insert Worksheet tab 

 

To rename a worksheet: 

1. On the Sheet tab bar, right-click the sheet tab that you want to 

rename, and then click Rename Sheet (Figure 1.4).  

2. Select the current name, and then type the new name. 

 

 
 

Figure 1.4 – The renaming of the Worksheet Sheet2 
 

Entering data in a worksheet: 

You have several options when you want to enter data manually in 

Excel.  

You can enter data in one cell; 

– in several cells at the same time, or  

– on more than one worksheet at the same time. 

The data that you enter can be  

– numbers; 

– text; 

– dates; 

– time. 

 

1.3. Adjust settings 

1. To wrap text in a cell, select the cells that you want to format, and 

then on the Home tab, in the Alignment group, click Wrap Text 

(Figure 1.5a). 
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2. To adjust column width and row height to automatically fit the 

contents of a cell, select the columns or rows that you want to change, and 

then on the Home tab, in the Cells group, click Format(Figure 1.5b). 

3. To quickly autofit all columns or rows in the worksheet, click the 

Select All button (Figure 1.5c), and then double-click any boundary 

between two column or row headings. 
 

  
 

a b c 
 

Figure 1.5 – Adjust settings 
 

1.4. Format the data 

1. To apply number formatting, click the cell that contains the 

numbers that you want to format, and then on the Home tab, in the 

Number group, click the arrow next to General (Figure 1.6a), and then 

click the format that you want.  

2. To change the font, select the cells that contain the data that you 

want to format, and then on the Home tab, in the Font group (Figure 1.6b), 

click the format that you want. 

 

  

a b 

 

Figure 1.6 – Format data 
 

1.5. Format numbers 

1. Select the cells that you want to format. 

2. One the Home tab, in the Number group, click the Dialog Box 

Launcher next to Number (Figure 1.7a). 
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3. In the Category list, click the format that you want to use, and 

then adjust settings, if necessary (Figure 1.7b). 
 

 

 

a b 
 

Figure 1.7 – Format numbers 
 

Available number formats 

By applying different number formats (Table 1.1), you can change 

the appearance of a number without changing the number itself. A number 

format does not affect the actual cell value that Excel uses to perform 

calculations. The actual value is displayed in the formula bar. 
 

Table 1.1 – The list of available number formats 

Format Description 

General 

The default number format that Excel applies when you type a 

number. For the most part, numbers that are formatted with 

the General format are displayed just the way you type them 

Number 

Used for the general display of numbers. You can specify the 

number of decimal places that you want to use, whether you 

want to use a thousands separator, and how you want to 

display negative numbers. 

Currency 

Used for general monetary values and displays the default 

currency symbol with numbers. You can specify the number 

of decimal places that you want to use, whether you want to 

use a thousands separator, and how you want to display 

negative numbers. 
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The end of the table 1.1 

Format Description 

Accounting 
Also used for monetary values, but it aligns the currency 

symbols and decimal points of numbers in a column. 

Date 
Displays date and time serial numbers as date values, 

according to the type and locale (location) that you specify.  

Time 
Displays date and time serial numbers as time values, 

according to the type and locale (location) that you specify.  

Percentage 

Multiplies the cell value by 100 and displays the result with 

a percent (%) symbol. You can specify the number of 

decimal places that you want to use. 

Fraction 
Displays a number as a fraction, according to the type of 

fraction that you specify. 

Scientific 

Displays a number in exponential notation, replacing part of 

the number with E+n, where E (which stands for Exponent) 

multiplies the preceding number by 10 to the nth power. For 

example, a 2-decimal Scientific format displays 

12345678901 as 1.23E+10, which is 1.23 times 10 to the 

10th power.  

Text 
Treats the content of a cell as text and displays the content 

exactly as you type it, even when you type numbers. 

Special 
Displays a number as a postal code (ZIP Code), phone 

number, or Social Security number.  

Custom 
Allows you to modify a copy of an existing number format 

code.  

 

1.6. Apply cell borders 

1. Select the cell or range of cells that you want to add a border to. 

2. On the Home tab, in the Font group, click the arrow next to 

Borders (Figure 1.8), and then click the border style that you want. 
 

 
 

Figure 1.8 – Applying cell borders 
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1.7. Absolute, relative and mixed references 

1. Relative references (Figure 1.9a) 

A relative cell reference in a formula, such as A1, is based on the 

relative position of the cell that contains the formula and the cell the 

reference refers to. If the position of the cell that contains the formula 

changes, the reference is changed. If you copy or fill the formula across 

rows or down columns, the reference automatically adjusts. Bydefault, new 

formulas use relative references. For example, if you copy or fill a relative 

reference in cell B2 to cell B3, it automatically adjusts from =A1 to =A2. 

2. Absolute references (Figure 1.9b) 

An absolute cell reference in a formula, such as $A$1, always refer 

to a cell in a specific location. If the position of the cell that contains the 

formula changes, the absolute reference remains the same. If you copy or 

fill the formula across rows or down columns, the absolute reference does 

not adjust. By default, new formulas use relative references, so you may 

need to switch them to absolute references. For example, if you copy or fill 

an absolute reference in cell B2 to cell B3, it stays the same in both cells: 

=$A$1. 

3. Mixed references (Figure 1.9c) 

Amixed reference has either an absolute column and relative row, or 

absolute row and relative column. An absolute column reference takes the 

form $A1, $B1, and so on. An absolute row reference takes the form A$1, 

B$1, and so on. If the position of the cell that contains the formula changes, 

the relative reference is changed, and the absolute reference does not 

change. If you copy or fill the formula across rows or down columns, the 

relative reference automatically adjusts, and the absolute reference does not 

adjust. For example, if you copy or fill a mixed reference from cell A2 to 

B3, it adjusts from =A$1 to =B$1. 

 
 

 

а b c 
 

Figure 1.9 – Absolute, relative and mixed references 
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Subject 2. CALCULATIONS IN EXCEL 

 

2.1. Calculation operators and precedence 

Operators specify the type of calculation that you want to perform 

on the elements of a formula. There is a default order in which calculations 

occur, but you can change this order by using parentheses. 

There are four different types of calculation operators:  

– arithmetic,  

– comparison, 

– text concatenation, and  

– reference. 

Arithmetic operators 

To perform basic mathematical operations, such as addition, 

subtraction, multiplication, or division; combine numbers; and produce 

numeric results, use the arithmetic operators presented in Table 2.1. 

 

Table 2.1 – The list of available arithmetic operators 

Arithmetic operator Meaning Example 

+ (plus sign) Addition 3+3 

– (minus sign) 
Subtraction 

Negation 

3–1 

–1 

* (asterisk) Multiplication 3*3 

/ (forward slash) Division 3/3 

% (percent sign) Percent 20% 

^ (caret) Exponentiation 3^2 

 

Comparison operators 

It is possible to compare two values with the operators presented in 

Table 2.2. When two values are compared by using these operators, the 

result is a logical value – either TRUE or FALSE. 
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Table 2.2 – The list of available comparison operators 

Comparison operator Meaning Example 

= (equal sign) Equal to A1=B1 

> (greater than sign) Greater than A1>B1 

< (less than sign) Less than A1<B1 

>= (greater than or equal to sign) Greater than or equal to A1>=B1 

<= (less than or equal to sign) Less than or equal to A1<=B1 

<> (not equal to sign) Not equal to A1<>B1 

 

Text concatenation operator 

To produce a single piece of text the operators such as ampersand 

(&) to concatenate (join) one or more text strings are used (Table 2.3). 

 

Table 2.3. – The text concatenation operator 

 

Reference operators 

Reference operators combine ranges of cells for calculations with the 

operators presented in Table 2.4. 

 

Table 2.4 – The list of available reference operators 

Textoperator Meaning Example 

& 

(ampersand) 

Connects, or concatenates, two values 

to produce one continuous text value  

"North"&"wind" 

results in "Northwind" 

Reference 

operator 
Meaning Example 

: (colon) 

Range operator, which produces one 

reference to all the cells between two 

references, including the two references. 

B5:B15 

, (comma) 
Union operator, which combines 

multiple references into one reference  
SUM(B5:B15,D5:D15) 

(space) 

Intersection operator, which produces 

one reference to cells common to the 

two references 

B7:D7 C6:C8 
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Calculation order 

Formulas calculate values in a specific order.  

1. A formula in Excel always begins with an equal sign (=). Excel 

interprets the characters that follow the equal sign as a formula.  

2. Following the equal sign are the elements to be calculated (the 

operands), such as constants or cell references.  

3. These are separated by calculation operators.  

4. Excel calculates the formula from left to right, according to a 

specific order for each operator in the formula. 

 

Operator precedence 

If you combine several operators in a single formula, Excel performs 

the operations in the order shown in the Table 2.5.  

 

Table 2.5 – Operator precedence  

Operator Description 

: (colon)  

(single space) 

, (comma) 

Reference operators 

– Negation (as in –1) 

% Percent 

^ Exponentiation 

* and / Multiplication and division 

+ and – Addition and subtraction 

& Connects two strings of text (concatenation) 

= 

<> 

<= 

>= 

<> 

Comparison 

 

If a formula contains operators with the same precedence Excel 

evaluates the operators from left to right. 
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Use of parentheses 

To change the order of evaluation, enclose in parentheses the part of 

the formula to be calculated first. 

 

Table 2.5 – Operator precedence  

Problem Solution 

To change the order of evaluation, enclose in 

parentheses the part of the formula to be 

calculated first. 

=5+2*3 Will be 11 

In contrast, if you use parentheses to change the 

syntax: 
=(5+2)*3 Will be 21 

In the following example, the parentheses that 

enclose the first part of the formula force Excel to 

calculate B4+25 first and then divide the result by 

the sum of the values in cells D5, E5, and F5. 

=(B4+25)/SUM(D5:F5) 

 

Formulas in Excel 

Formulas are equations that perform calculations on values in your 

worksheet. A formula always starts with an equal sign (=). 

Depending on the type of formula that you create, a formula can 

contain any or all of the following parts (Figure 2.1): 

1. Functions: The PI() function returns the value of pi: 3.142... 

2. References: A2 returns the value in cell A2. 

3. Constants: Numbers or text values entered directly into a 

formula, such as 2. 

4. Operators: The ^ (caret) operator raises a number to a power, 

and the * (asterisk) operator multiplies numbers. 

 

 

Figure 2.1 – Parts of standard formula 
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Using constants in formulas 

A constant is a value that is not calculated; it always stays the same. 

For example, the date 10/9/2008, the number 210, and the text "Quarterly 

Earnings" are all constants. An expression or a value resulting from an 

expression is not a constant.  

Using calculation operators in formulas 

Operators specify the type of calculation that you want to perform on 

the elements of a formula. There is a default order in which calculations 

occur (this follows general mathematical rules), but you can change this 

order by using parentheses. 

Using the A1 reference style in formulas 

A reference identifies a cell or a range of cells on a worksheet, and 

tells Excel where to look for the values or data you want to use in a 

formula. It is possible to settle references to use data contained in different 

parts of a worksheet in one formula or use the value from one cell in 

several formulas. You can also refer to cells on other sheets in the same 

workbook, and to other workbooks. References to cells in other workbooks 

are called links or external references. The reference formats are listed in 

Table 2.6. 

 

Table 2.6 – Reference style in Excel 

To refer to Use 

The cell in column A and row 10 A10 

The range of cells in column A and rows 10 through 20 A10:A20 

The range of cells in row 15 and columns B through E B15:E15 

All cells in row 5 5:5 

All cells in rows 5 through 10 5:10 

All cells in column H H:H 

All cells in columns H through J H:J 

The range of cells in columns A through E and rows 10 

through 20 

A10:E20 

 

Using functions and nested functions in formulas 

Functions are predefined formulas that perform calculations by using 

specific values, called arguments, in a particular order, or structure. 

Functions can be used to perform simple or complex calculations. The 

example of nested function is given in Figure 2.2 and explained in 

Table 2.7. 
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Figure 2.2 – Nested functions in formula 

 

Table 2.7 – The parts of nested functions in formula 

 

Structure. The structure of a function begins with an equal sign (=), 

followed by the function name, an opening parenthesis, the 

arguments for the function separated by commas, and a closing 

parenthesis. 

 
Function name. For a list of available functions, click a cell and 

press SHIFT+F3. 

 

Arguments. Arguments can be numbers, text, logical values such 

as TRUE or FALSE, arrays, error values such as #N/A, or cell 

references. The argument you designate must produce a valid value 

for that argument. Arguments can also be constants, formulas, or 

other functions. 

 

Argument tooltip. A tooltip with the syntax and arguments appears 

as you type the function. For example, type =ROUND( and the 

tooltip appears. Tooltips appear only for built-in functions. 

 

Entering functions 

If to create a formula that contains a function, it is possible to use the 

Insert Function dialog box to enter worksheet functions. When entering a 

function into the formula, the Insert Function dialog box displays  the 

following parameters: 

– the name of the function,  

– each of its arguments,  

– a description of the function and each argument,  

– the current result of the function, and  

– the current result of the entire formula. 

To make it easier to create and edit formulas and minimize typing 

and syntax errors, use Formula AutoComplete. After you type an = (equal 
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sign) and beginning letters or a display trigger, Excel displays, below the 

cell, a dynamic drop-down list of valid functions, arguments, and names 

that match the letters or trigger. You can then insert an item from the drop-

down list into the formula. 

The list of some math, trigonometry and array functions available in 

Excel with their explanation is given in Table 2.8. The list of logical 

functions is presented in Table 2.9. 
 

Table 2.8 – Math, trigonometry and array functions in Excel 

Function Description 

ABS  Returns the absolute value of a number 

ACOS  Returns the arccosine of a number 

ASIN  Returns the arcsine of a number 

ATAN  Returns the arctangent of a number 

COS  Returns the cosine of a number 

DEGREES  Converts  radians to degrees 

EVEN  Rounds a number up to the nearest even integer 

EXP  Returns e raised to the power of a given number 

FACT  Returns the factorial of a number 

FLOOR  Rounds a number down, toward zero 

GCD  Returns the greatest common divisor 

INT  Rounds a number down to the nearest integer 

LCM  Returns the least common multiple 

LN  Returns the natural logarithm of a number 

LOG  Returns the logarithm of a number to a specified base 

LOG10  Returns the base-10 logarithm of a number 

MDETERM  Returns the matrix determinant of an array 

MINVERSE  Returns the matrix inverse of an array 

MMULT  Returns the matrix product of two arrays 

MOD  Returns the remainder from division 

MROUND  Returns a number rounded to the desired multiple 

MULTINOMIAL  Returns the multinomial of a set of numbers 

ODD  Rounds a number up to the nearest odd integer 
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The end of the table 2.8 

Function Description 

PI  Returns the value of pi 

POWER  Returns the result of a number raised to a power 

PRODUCT  Multiplies its arguments 

QUOTIENT  Returns the integer portion of a division 

RADIANS  Converts degrees to radians 

RAND  Returns a random number between 0 and 1 

ROMAN  Converts an arabic numeral to roman, as text 

ROUND  Rounds a number to a specified number of digits 

ROUNDDOWN  Rounds a number down, toward zero 

ROUNDUP  Rounds a number up, away from zero 

SIGN  Returns the sign of a number 

SIN  Returns the sine of the given angle 

SQRT  Returns a positive square root 

SUM  Adds its arguments 

SUMIF  Adds the cells specified by a given criteria 

TAN  Returns the tangent of a number 

TANH  Returns the hyperbolic tangent of a number 

TRUNC  Truncates a number to an integer 

 

Table 2.9 – Logical functions in Excel 

Function Description 

AND  Returns TRUE if all of its arguments are TRUE 

FALSE  Returns the logical value FALSE 

IF  Specifies a logical test to perform 

IFERROR  Returns a value you specify if a formula evaluates to an 

error; otherwise, returns the result of the formula 

NOT  Reverses the logic of its argument 

OR  Returns TRUE if any argument is TRUE 

TRUE  Returns the logical value TRUE 
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2.2. Calculation examples in Excel 

Task 2.1. Calculate the value of the expression 
 

2 2

sin

1 sin

x
z

m x  
 

With the given values: 1.5; 5.74x m . 
 

Solution(Figure 2.3): 

1. In cells A1 and A2 input the description text ―x=― and ―m=―.  

2. In cell A3 input the description text ―z=―.  

3. Enter the values of x and m to cells B1 and B2 correspondingly. 

B1 cell should contain the number 1,5 and B2 – 5,74. Format the data 

applying number format. 

4. In the cell B3 enter the formula:  

 

= SIN(B1) / SQRT(1+B2^2*SIN(B1)^2) 

 

 

Figure 2.3 – The solution of Task 2.1 in Excel 

 

Task 2.2. Tasks for laboratory work. 
 

Table 2.10 – Variants for calculation 

№ Relations for calculation Initial data 

1 2 3 

1 
2

2

2

2cos( 6)

1 2 sin

1
3 5

x
a

y

z
b

z

 

1.426

1.22

3.5

x

y

z
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The end of the table 2.10 

1 2 3 

2 3

2

( )
( )

1 ( )

y xx y x

y z y x
y x

y x

 

1.825

18.225

3.298

x

y

z

 

3 

2

sin( )

sin( cos2 ) 1

bty e at b bt a

s b at t
 

0.5

1.7

0.44

a

b

t

 

4 2 2 3

2 3 2 2

sin ( )

cos

x b b x a x

y x x a b

 
1.5; 15.5

2.9

a b

x
 

5 3 2 2

2

tg ( )

1ax

s x x b a x b

bx a
Q

e

 

16.5

3.4

0.61

a

b

x

 

6 2 2

2 3

( 1) sin ( )

cos ( )

R x x b x a

S xb a x b
 

0.7

0.05

0.5

a

b

x

 

7 3 2 2

2
3

sin ( )

cos( )

y x a x b

x
z x b

a

 

1.1

0.004

0.2

a

b

x

 

8 3 tg sin

cos( sin )

f m t c t

z m bt t c
 

2 ; 1

1.2 ; 0.7

m c

t b
 

9 3 2

2

ln (1 )

7 2
sin cos

3,75

y x

x
F x

 

1.45x  

10 2 2ln( ) sin ( )

cx

f a x x b

x x a
z e

x x b

 

10.2 ; 9.2

2.2 ; 0.5

a b

x c
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Task 2.3.Tasks for individual work 

 

Table 2.11 – Variants for calculation 

№ Relations for calculation Initial data 

1 2 3 

1 2

2 3 2 2

sin 2 ( )

cos

xz ax x e x b

x x a b
 

0.5

3.1

1.4

a

b

x

 

2 2

2 3

cos

sin 1

ln( ) ln( )

x

x

x x

a x e bx
U

bx e bx

f e a x b b x

 

0.5

2.9

0.3

a

b

x

 

3 

2 2

sin
ln

1 sin

1 1.5ax bx

x
z cm mx

m x

s e x e x

 

0.7; 2.1

1.7; 0.5

1.08

m c

x a

b

 

4 2 2 3

2 3 2 2

sin ( )

cos

x b b x a x

y x x a b
 

1.5

15.5

2.9

a

b

x

 

5 0.52 ( 4 )y c b b ac  

29.2cos sin
1.2

x
F x

x
 

2; 3

4; 2.34

a b

c x
 

6 42 xy x x c  

12.4sin 8.3cos 2
2

x
F x  

4.741

0.5

x

c
 

7 3
sinxy e x c  

cos 9.1sin 2
2.7

x
F x  

2.312

1.5

x

c
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Continuation of the table 2.11 

1 2 3 

8 2

2
tg

sin ( )

cos( )a

a
y b x

x a

d ae bx a

 

3.2

17.5

4.8

a

b

x

 

9 22 , 2t h g v gt  

cos 2
sin(3 2.1)

2

x
F x

x
 

9.81; 350

3.65

g h

x
 

10 3

2

( )
( )

1 ( )

y xx y x

y z y x
y x

y x

 

1.825

18.225

3.298

x

y

z

 

11 3 2 2

2
3

sin ( )

cos( )

y x a x b

x
z x b

a

 

1.1

0.004

0.2

a

b

x

 

12 
2

2
tg

sin ( )

cos( )a

a
y b x

x a

d ae bx a

 

3.2

17.5

4.8

a

b

x

 

13 2

2 2 3

cos( )

1

sin ( )

x xa b a b x
y

x

R x b b x a x

 

0.3

0.9

0.61

a

b

x

 

14 

2

sin( )

sin( cos2 ) 1

bty e at b bt a

s b at t
 

0.5

1.7

0.44

a

b

t

 

15 2 2

2 3

( 1) sin ( )

cos ( )

R x x b x a

S xb a x b
 

0.7

0.05

0.5

a

b

x
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The end of the table 2.11 

1 2 3 

16 2 2 3 3 2 2( ) ( ) ( )c a b a a b a b  

2 2 3.1
sin cos sin

2

x
F x x  

2.71; 1.5

1.78

a b

x
 

17 1 1(1 ( ) ) (1 ( ) )c a x a x  

2

3.1

x
F tg  

1.25

0.25

a

x
 

18 

1 1

(2 ), (2 )

( 1) ( 1)

a d b d

c a b
 

2 2
cos sin 5.1

1.15

x
F x  

3

1.7

d

x
 

19 ( )zc x y  

sin(2 3)

cos(2 1.2 ) 2.56

x
F

x
 

4.65

2.87

3

x

y

z

 

20 3 2 2

2

tg ( )

1ax

s x x b a x b

bx a
Q

e

 

16.5

3.4

0.61

a

b

x
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2

sin( )

sin( cos2 ) 1

bty e at b bt a

s b at t
 

0.5

1.7

0.44

a

b

t

 

22 2 2ln( ) sin ( )

cx

f a x x b

x x a
z e

x x b

 

10.2; 9.2

2.2; 0.5

a b

x c
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Subject 3. LOGICAL FUNCTIONS IN EXCEL 

 

3.1. Decision Structure 

The decision structure takes place when one of two possible actions 

is taken, depending on a condition. 

In flowchart notation a diamond symbol indicates a yes/no question 

(Figure 3.1): 

1. If the answer to the question is yes, the flow follows one path.  

2. If the answer is no, the flow follows another path 

 

 
Figure 3.1 – Flowchart with diamond symbol of decision structure 

 

In the flowchart segment below, the question ―is x < y?” is asked. If 

the answer is no, then process A is performed. If the answer is yes, then 

process B is performed (Figure 3.2). 

 

 
 

Figure 3.2 – Flowchart with selection if x less than y 
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The decision structure in Excel (IF function) is shown on flowchart 

segment at Figure 3.3. In case, when  the resulting value is , in 

other case it is . Mathematically it can be expressed by following 

relation: 

, if

2 ,      if

x y x y
m

x x y
 

 

 
Figure 3.2 – Flowchart with selection if x less than y 

 

Let’s consider, that  value is in A1 cell and  value is in B2 cell. In 

this case the decision structure in Excel will be expressed by following IF 

function: 

 

 

3.2. IF … THEN  function 

Some functions do not calculate values but instead do logical tests 

using logical comparison operators. When two values are compared by 

using these operators, the result is a logical value — either TRUE or 

FALSE. The list of comparison operators used in Excel is listed in 

Table 3.1. Such test allows to do one thing when the comparison is true and 

something different when it is false. 

The IF function has three arguments inside parentheses, which are 

separated by commas: 

– The comparison statement; 

– The cell value to use when the comparison is true; 

– The cell value to use when the comparison is false. 
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Table 3.1 – Comparison operators 

Comparisonoperator Meaning Example 

= (equal sign) Equal to A1=B1 

> (greater than sign) Greater than A1>B1 

< (less than sign) Less than A1<B1 

>= (greater than or equal to sign) Greater than or equal to  A1>=B1 

<= (less than or equal to sign) Less than or equal to  A1<=B1 

<> (notequaltosign) Not equal to A1<>B1 

 

The general form of an IF function is: 
 

 
 

A resulted value can be a number, text within double quotes, a cell 

reference, a formula, or another logical test. 
 

3.3. Example of IF function 

In the example the list of people in the group with their test results 

are listed in Excel spreadsheet (Figure 3.3). The person passes the 

examination, if  his percent is more than 70. At the third column it is 

needed to provide the corresponding information: pass or failed. 
 

 

Figure 3.3 – Summer examination example 
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Solution: 

1. Enter the information provided in Figure 3.3. 

2. Move the cursor to cell C4. 

3. Use the function wizard: click on fx button (Figure 3.4a). The 

dialog box of function selection will appear (Figure 3.4b).Select IF 

function. 

 

 

a b 

Figure 3.4 – Insert function dialog box 

 

4. The Function Arguments box will appear (Figure 3.5). 
 

 

Figure 3.5 – IF Function Arguments box 
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5. The first box ―logical test‖ is for estimating the condition. It 

gives the result of logical test: TRUE or FALSE. In this example, it is 

needed to know if the percentage for the examination is more than 70. The 

result of  Picard, J examination is in B3 cell. It is needed to test if the value 

in B3 cell is greater than 70. Type  in the box with logical test 

(Figure 3.6). 

6. When the logical test is in place, it is needed to tell what we want 

to display if the condition is met (TRUE) and what we want to display if 

this condition is not met (FALSE). In this example when the value in 

percent column is more than 70 (TRUE), we need to display Pass. Type 

―Pass‖ in the ―Value_if_true‖ box (Figure 3.6). 

7. In opposite case (when FALSE) we need to display Fail. Type 

―Fail‖ in the ―Value_if_false‖box (Figure 3.6). 
 

 

Figure 3.6 – The complete parameters in IF Function Arguments box 

 

8. Press OK button. In C4 cell the information ―Pass‖ will appear. 

9. Copy the C4 cell with the function to the other cells (C5:C7). It 

should provide the proper results. 
 

Task 3.4 

Calculate the value of the following function: 

2 , if 0

,   if 0

t p t
m

t p c t
 

With the following parameters: p = 0,5;  c = 1,2;  t = –2 and 3. 
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Solution 

1. In cells A1, A2 and A3 input the description text ―p=―, ―c=―  and 

―t=―. In cell A4 enter ―m=―. 

2. Enter the values of  and m to cells B1, B2 and the first value of 

(-2) in B3 cell correspondingly. 

3. In the cell B4 start to enter the formula ―IF‖ (Figure 3.7): 

4. Choose IF function and click button ―fx‖.  

The Function Argument dialog box for function IF appears. Enter 

the proper arguments in the fields and press OK button (Figure 3.8). 

5. Enter the next value of in B3 ( ). 

 

 

Figure 3.7 – The entering of function 

 

 

Figure 3.8 – The completed parameters in IF Function Arguments box  

for Task 3.4 
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The results of Task 3.4 for different  values are given in Figure 3.9. 

 

1.  

 

2.   

 
 

Figure 3.9 – The calculation results of Task 3.4  

 

Task 3.5. Tasks for laboratory work 

Calculate the expressions listed in Table 3.2 for two cases:  

and  using Excel IF function. 

 

Table 3.2 - Variants for calculation 

№ Relations for calculation № Relations for calculation 

1 2 3 4 

1 2 2

0.13

1 2 sin( ) , 0

2
, 0

2 x

x x x

x
x

e

 

2 

2

5

3

1
0

2 cos (2 )

2
0

1

x
x

x

x x
x

x
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The end of the table 3.2 

1 2 3 4 

3 
30.1

25

2
2

2

1 2 sin 5
2

3

x

x
x

e

x
x

x

 

4 

3

1
, 1

2

1
, 1

2 cos( )

x
x

x

x
x

x

 

5 

3

3

4 2

2 2

2
x x

x x x

x
x

e

 

6 

3

1

3

0.1

3

2
3

2 x

x x

x
x

e

 

7 

0.14

1 sin( ), 0

, 0
x

x x x

x
x

e

 

8 
2

1 sin( )
, 0

1 (2 cos( ))

1 , 0

x
x

x

x x

 

9 
2

2

2

, 0
1

1 , 0

xx
e x

x

x x

 

10 2

2

, 1

1
, 1

1

xx e x

x
x

 

11 2

3

1 2 , 0

1
, 0

1 1 x

x x

x
x

e

 

12 2

3

2 1 , 0

1
, 0

1 x

x x

x
e

 

 

Task 3.6 

Calculate the value of the following function: 
 

2

2

( 1) , 0

1/ ( 1) , 0 4

sin ( 1), 4

t bc t

m t t

t t

 

 

With the following parameters: b = 0.5; c = 1.2; t = –2; 3;5. 
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Solution 

1. In cells A1, A2 and A3 input the description text ―b=―, ―c=― and 

―t=― correspondingly. In cell A4 enter ―m=―. 

2. Enter the values of  and  to cells B1, B2 and the first value of 

 in B3 cell correspondingly. 

3. In the cell B4 start to enter the formula ―IF‖ (Figure 3.10). 
 

 

Figure 3.10 – The entering of function 

 

4. Choose IF function and click button ―fx‖ 

5. Start to enter arguments of IF function in Function Argument 

dialog box. The entered values for ―Logical_test‖ - B3 <0 and 

―Value_if_true‖ - B3^2+1)*B1*B2 are presented in Figure 3.11. Then 

close it by clicking OK. 
 

 

Figure 3.11 – The entering of IF function parameters 
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6. As ―Value_if_false‖ argument in the formula box start enter IF 

function and then press button ―fx‖ (Figure 3.12). 

7. The Function Argument dialog box for the nested function IF 

appears. Enter the remained arguments in the proper fields and press OK 

button (Figure 3.13). 

 

 

Figure 3.12 – The entering of nested IF function 

 

 

Figure 3.13 – The entering of nested IF function parameters 

 

The results of Task 3.4 for different  values are given in 

Figure 3.14. 
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1.   

 

2.   

 

3.   

 
 

Figure 3.14 – The calculation results of Task 3.4  

 

Task 3.7. Tasks for laboratory work 

 

Table 3.3 – Variants for calculation 

№ Relations for calculation Test condition Initial data 

1 2 3 4 

1 

3

sin

cosax

x x a

x ax

e ax

 

x a

x a

x a

 
2.5

3;  2.5;  1

a

x
 

2 

lg( 1) 

( ) / 2 

1

ay

x ay b

a

 

10

10

10

y

y

y

 
0.2;  0.01;

2;  10;  12.5

a b

y
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The end of the table 3.3 

1 2 3 4 

3 

cos( )

1

sinx

x

s a b x

e x

 

2.8

2.8 6

6

x

x

x

 

2.6

0.39

2;  3;  6.2

a

b

x

 

4 

( ) 2

lg( )

(( )

a b x

f x a b

a b x a

 

  1

 1

  1

x

x

x

 
0.7;  0.31

2.4;  1;  0.5

a b

x
 

5 

1 ,

(1 )

(1 ) 0.5

x

s xb a

x

 

  0

  0

  0

x

x

x

 
7.2;   0.001

0; 3; 5.4

a b

x
 

6 

( 1.5 ) 2m y

x mb y

y mb

 

  2

  2

  2

y

y

y

 
 0.2;     5;

4;  1.5;  2

b m

y
 

7 

3.5 15.2

8.1 sin( 1)

(1.2 5.1 )

x y

s x y

x y a

 

  5

  5

  5

y

y

y

 
 0.1;  3

7;  5;  2.67

a x

y
 

8 

1

(( 1) ) / ( )

y

f y b

y b a b

 

   1

   1

   1

y

y

y

 
0.2;   0.3

2;   1; 4.8

a b

y
 

9 

1 cos

( ) 2

1

x y

f ay b

a

 

  0

  0

  0

y

y

y

 

0.2;   0.001

2

2;  0;  5.8

a b

x

y

 

10 

1 cos

 

( / )

a x

m ax b

x b a

 

  1

  1

  1

x

x

x

 
0.001;  5.1

3; 1; 8.56

a b

x
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Task 3.8. Tasks for individual work 
 

Table 3.4 – Variants for calculation 

№ Relations for calculation Test condition Initial data 

1 2 3 4 

1 

2

3 2

sin

ln  1

x

y x

x c

 

0

0

0

x

x

x

 
1.57

3; 2.5;  0

с

x
 

2 
2

/ sin( )      

( )      

       

a x c

y a c x

a c

 

0

0

0

x

x

x

 

  1.5;     0.45

2; 3.5;  0

a c

x

 

3 

2 2

3

7

7

ln( 7)

x x

Q ax x

x x a

 

1.4

1.4

1.4

x

x

x

 
1.65

1; 1.4; 5

a

x
 

4 

3

2

0.3

0                  

                  

y

g

y y

 

0

0 1

1

y

y

y

 
    2;   

 3; 1.5;  0

y z

z
 

5 

2( 1)

( 1) /

x b

w x b

b

 

0

0

0

x

x

x

 
  1.5

2;  5;  0

b

x
 

6 

2

2

2

/ (1 / 2)     

( / (1 / 2))

( / (1 / 2))x

x x

с x x x

e x x

 

1

1 2

2

x

x

x

  0.5;  1.85;  3x  

7 
2

3

/12       

15

4                   

x

y x

x

 

3

3 10

10

x

x

x

 0.5; 7;  14x  
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Continuation of the table 3.4 

1 2 3 4 

8 

2

2

2

1

( ) 1

ax bx c

a x x

a bx x

 

1.2

1.2

1.2

x

x

x

 

2.8;   0.3;

4

 1;  1.2;  3

a b

c

x

 

9 

2

2

( 1)

1 / ( 1)

sin( 1)

t bc

m t

t

 

0

0 4

4

t

t

t

 

  0.5;       1.2;   

 2;  3;  5.67

b c

t

 

10 

3

sin

cosax

x x a

x ax

e ax

 

x a

x a

x a

 
2.5

3;  2.5;  1

a

x
 

11 

lg( 1) 

( ) / 2 

1

ay

x ay b

a

 

10

10

10

y

y

y

 
0.2;  0.01;

2;  10;  12.5

a b

y
 

12 

3 2

2

(ln )

1

cos sin

x x x t

z x t t

x t x

 

0.5

0.5

0.5

x

x

x

 
2.2

0.3;  0.5;  1

t

x
 

13 

( cos )

1

sin

x

x

a b e x

s a b x

e x

 

2.8

2.8 6

6

x

x

x

 

2.6

0.39

2;  3;  6.2

a

b

x

 

14 

2

3

a
bi c

i

i

ai bi

 

4

4 6

6

i

i

i

 

2.1;  1.8

20.5

 3;  5;  6.7

a b

c

i
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The end of the table 3.4 

1 2 3 4 

15 

2

2

sin 1

cos 1

at b t

at b

at b t

 

0.1

0.1

0.1

t

t

t

 

2.5

0.4

 0.05;  0.1;  2

a

b

t

 

16 

( ) 2

lg( )

( )

a b x

f x a b

a b x a

 

 > 1

 =1

 < 1

x

x

x

 
0.7;  0.31

2.4;  1;  0.5

a b

x
 

 

Task 3.9. Working with flowchart 

Using IF function, do the calculations according to the flow chart 

presented in Figure 3.15 with the following x values: 10, , ,x . 
 

 

Figure 3.15 – The flowchart for Task 3.9 

START

Input

a = 3

b = 15

Input x

X < 0 ?

m=(3x2+a)/b

YES NO

X > 3 ?

YES

NO

m= (a+b)2*x
X < 10

YES

NO

m= (b-a)/x m=‖infinity‖

m

END

YES

x = -10;

x = 2;

x = 5;

x = 15
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Subject 4. PLOTTING CHARTS 

 

4.1. Chart the data 

Charts are used to display series of numeric data in a graphical 

format to make it easier to understand large quantities of data and the 

relationship between different series of data. 

To create a chart in Excel, it is needed to enter the numeric data for 

the chart on a worksheet. Then it is possible to plot that data into a chart by 

selecting the chart type on the Insert tab, in the Charts group. The 

procedure needs to do the following steps: 

1. Select the data to chart. 

2. On the Insert tab, in the Charts group, select the chart type 

(Figure 4.1a), and then a chart subtype (Figure 4.1b). 

 

 

a b 

Figure 4.1 – Charts group on Insert tab 

3. Use the Chart Tools on Design, Layout and Format tab to add 

chart elements such as titles and data labels, to change the design, layout, 

or format of your chart. 

Excel provides the following chart types: 

– Column charts 

– Line charts 

– Pie charts 

– Bar charts 

– Area charts 

– XY (scatter) charts 

– Stock charts 

– Surface charts 

– Doughnut charts 

– Bubble charts  

– Radar charts 



41 

The elements of a chart 

The chart area in Excel consists of the basic elements presented in 

Figure 4.2 and listed in Table 4.1. 

 

 
 

Figure 4.2 – Chart elements 

 

Table 4.1 – The description of chart elements 

№ Description 

 The chart area of the chart. 

 The plot area of the chart. 

 The data points of the data series that are plotted in the chart. 

 
The horizontal (category) and vertical (value) axis along which the 

data is plotted in the chart. 

 The legend of the chart. 

 A chart and axis title that you can use in the chart. 

 
A data label that you can use to identify the details of a data point in 

a data series 
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Task 4.2 

Plot the graph of function 

0.15( ) 65.5 tf t e  

In the range ; with the step . 

 

Solution 

1. Input the names of columns t and f(t) in cells C2 and D2 

correspondingly (Figure 4.3). 

2. Input the first and the second value of t in cells C3 and    

C4(  and enter the formula for function f(t) in D3 cell 

( ) (Figure 4.3). 

 

 

 

Figure 4.3 – Task 4.2 solution, step 1 and 2 
 

3. By selecting two cells C3 and C4 and then dragging them, 

increase the t values till it will be equal 15 (Figure 4.4). 

 

 

 

Figure 4.4 – Creating the column with t values 
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4. And copy the formula by dragging the cell D3 (Figure 4.5a).The 

two columns presented in Figure 4.5b one with the argument t values and 

other with function f(t)values should be created. 
 

  

a b 

Figure 4.5 – Creating the columns with argument and function values 
 

5. Select the cell F7 where the graph will be plotted and go to 

Insert tab, Charts group, select Scatter with smooth lines and markers 

(Figure 4.6). 
 

 

Figure 4.6 – Selecting Scatter with smooth lines and markers to plot the graph 

by points  
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6. Press Select Data button(Figure 4.7). 

 

 
Figure 4.7 – Selecting data for the chart 

 

7. Input the chart data range by selecting cells C3:D19 on the 

worksheet (Figure 4.8). 

 

 
Figure 4.8 – Selecting data for the chart 

 

8. Press Edit button and check values for  and (Figure 4.9). 
 

 

Figure 4.9 – Edit data for the chart 
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9. Use the Layout tab to modify the view of your chart 

(Figure 4.10). 

 

 
 

Figure 4.10 – Layout tab to modify the view of the chart 

 

10. Press OK button. The graph of function presented in 

Figure 4.11 will appear. 

 

 
 

Figure 4.11 – The graph of function
0.15( ) 65.5 tf t e  

in the range , step  

 

Task 4.3. Tasks for laboratory work 

Plot the graph of function presented in Table 4.2 on the given range. 

Take the appropriate increment for building the graph of function. 
 

Table 4.2 – Variants for calculation 

№ Function The range of variables 

1 2 3 

1   
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The end of the table 4.2 

1 2 3 

2   

3   

4   

5   

6   

7   

8   

9   

10   

 

Task 4.4 

Do the Tasks listed in Table 4.3. 
 

Table 4.3 – Tasks for calculation 

№ Task description 

1 2 

1 Plot the graph of the reaction velocity according to the relation: 

0.103778.56 ; 1 25; 1K e  

2 Plot the graph of the humidity x (in percent of dry substance) 

depending from time t, min according to the relation:

1.4568 0.0093810 ; 0 100; 5tx t t  

3 Plot the graph of relation between the mixture amount y (in %), which 

is taken from the evaporation unit, and its output x (in kg/h) according 

to the equation: 

2.071 75.789 10 0.048; 250 2000; 100y x x x  
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The end of the table 4.3 

1 2 

4 Plot the graph of relation between the atmospheric pressure p (in 

mm Hg) and barometric height h (in km), according to the equation: 

0.0531760 10 ; 0 6; 0.2hp h h  

5 Plot the graph of relation between the atmospheric pressure p (in 

mm Hg) and barometric height h (in km), according to the equation: 

0.0531760 10 ; 0 6; 0.2hp h h  

6 Plot the graph of the humidity x (in percent of dry substance) 

depending from time t, min according to the relation: 

1.4568 0.0093810 ; 0 100; 5tx t t  

7 Plot the graph of relation between the air temperature inside the 

dryer T (in K) during the day, where τ are the hours, according to the 

equation 

80 14.99cos(15 37) 18cos(30 353)T ,      

0 24 

8 Plot the graph of the relation between the solubility of the sodium 

salt of hypochlorous acid in water x (in g/100 g of water) from its 

temperature t (in °C) according to the equation: 

0.19397.894 4.82; 0 60; 2tx e t t  

9 Plot the graph of the relation between the friction factor in tubes τ 

depending from the Reynolds number Re: 

0.254

0.398

Re ,           3000 Re 16000; Re 1000  

10 Plot the graph of the relation between the air volume content in 

water ν (in ml, taken at given temperature t, °C and 760 mm Hg) and 

temperature t, °C: 

( 5) ( 1.386 0.0375 ) 25.68; 0 25; 1t t t t
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Task 4.5.Tasks for individual work 

Plot the graph of function presented in Table 4.4 on the given range 

with the specified increment. 
 

Table 4.4 – Variants for calculation 

№ Function The range of variables Increment 

1 2 cos( ) 0.5y x x  3.14 3.14x  0.1h  

2 ln( ) 0.8y x x  1 7x  0.2h  

3 2 ln( ) 3y x x  0.1 3x  0.2h  

4 0.5( 1) 1y x x  0.2 5x  0.2h  

5 2 4 sin( )y x x  x  0.1h  

6 cos( ) 1y x x  1.7 4.5x  0.5h  

7 
3 sin( )y x x  x  0.1h  

8 2( 1) 1y x x  0 10x  1h  

9 25 lg( ) 5y x x  1 8x  0.5h  

10 sin( ) cos( )y x x  x  0.1h  

11 lg( 1) 4y x x  0,1 8x  0.1h  

12 2 ln( ) 2 1y x x  1 50x  5h  

13 3( )y arctg x x  0 25x  5h  

14 sin( )x xy x  0.1 4x  0.1h  

15 5 sin( )y x x  10 10x  1h  

16 3 sin( ) 5y x x  x  0.1h  

17 2( 1) 90y x x  0 10x  1h  

18 23 lg( ) 56y x x  0.2 5x  0.2h  

19 sin( ) cos( )y x x  x  0.1h  

20 2 4 sin( )y x x  x  0.1h  
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Subject 5. WORKING WITH TABLES IN EXCEL 

 

Task 5.1 

The typical engineering problems can be solved in Excel. For, 

example to find the content of working mass, what is the standard problem 

in heat engineering. 

It is needed to find the lowest combustion heat ( ), and 

highest combustion heat ( ) of the fuel with the following 

content of combusting mass: С
c
= 78.5%; Н

c
 = 5.6%; S

c
= 0.4%; N

c
= 2.5%; 

О
c
 = 13.0%. The ash content of working mass is А

w
 = 13.2%.The wetness 

of the working mass is W
w
 = 12.0%. 

The formulas for the highest and lowest combustion heat of the fuel 

(  and ) are: 
 

 338С 1025Н 108.5 О S 25w w w w w

LQ W , (5.1) 

 

 225Н 25w w

H LQ Q W . (5.2) 

 

The equation to determine the content working (w) mass: 
 

 
100

X
100

w w

w c
A W

X , (5.3) 

 

where X is the one of the fuel component: C – carbon; H – hydrogen;         

S – sulfur; N – nitrogen; O – oxygen. 
 

Solution 

1. Create the table with initial data:  

– С
c
 value, which is equal to 78.5% is in B3 cell;  

– Н
c
 value equal to 5.6% is in B4 cell;  

– S
c  

value equal to 0.4% is in B5 cell;  

– N
c  

value equal to 2.5% is in B6 cell;  

– О
c  

value equal to 13.0%is in B7 cell;  

– А
w  

value equal to 13.2%is in C8 cell;  

– W
w
 value equal to 12.0% is in C9 cell.  
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Draw the table borders and format the alignment of the data inside 

the cells. The resulting table with initial data is presented in Figure 5.1. 

 

 
 

Figure 5.1 – The table with initial data for Task 5.1 
 

2. Complete the table with the values, which should be calculated. 

In cell C3 enter the following formula according to Equation (5.3) 

with the reference to the corresponding cells: 
 

 
 

3. Use the absolute reference to the cellsC8 and C9 with ash content 

of working mass value (A
w
) and the wetness of the working mass value 

(W
w
) by putting ―$‖ sign before the column letter and row number. The 

changed formula cell C3 should look like: 
 

 
 

4. Copy the content of C3 cell to cells C4:C7.  

5. Calculate the sums automatically. It should be equal to 100 % for 

column with combusting mass (B) and for column with working mass (C). 

Calculate the lowest combustion heat ( ) of the fuel according 

to Equation (5.1), with reference to the cells with corresponding values  
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; 
 

and highest combustion heat ( ) of the fuel according to 

Equation (5.2)      

       

; 
 

The resulting table is presented in Figure 5.2. 

 

 

Figure 5.2 – The resulting table for Task 5.1 

 

Task 5.2 

Create the table presented in Figure 5.3 keeping the information in 

proper cells of the Excel worksheet. The task is to complete the table, doing 

the questions, listed below. You should make a judgement about which 

type of if statement is needed before you attempt to work out the formula. 

You can use the following functions:  

– IF… then 

– IF(AND…) 

– IF(OR…) 

– Nested IF statements 
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Question 1  

In column F, a formula needs to be written to identify whether a 

performance is in the evening or if it is a matinee performance.   

1. Write a formula in cell F9, so if a performance is on at 14.00 hours 

then the word ―Matinee‖ should be displayed, otherwise ―Evening‖ should 

be displayed. 

2. Replicate this formula for all performances.  

Question 2  

In column G, a formula needs to be written to display the cost of a 

performance. The cost depends on whether a performance is a matinee or 

evening performance. 

1. Write a formula in cell G9, so if a performance is a matinee, the 

cost displayed is 80.00 UAH, otherwise it is 100.00 UAH. 

2. Replicate this formula for all performances.   

Question 3  

In column H, a formula needs to be written to display whether a 

performance is sold out. All performances have the same number of seats 

available. 

1. Write a formula in cell H9, so if the number of seats sold is equal 

to 500, ―Sold Out‖ should be displayed, if the number of seats sold is 

greater than or equal to 400, ―On Target‖ should be displayed, otherwise 

―Undersold‖ should be displayed. 

2. Replicate this formula for all performances.  

Question 4  

In column I, a formula needs to be written to decrease the cost of 

remaining tickets for a performance. The new ticket price is calculated by 

checking if a performance is a matinee and is undersold. 

1. Write a formula in cell I9, so that if a performance is a matinee 

AND it is undersold, the price displayed should be the original ticket price 

– 10 UAH, otherwise the price should remain the same. 

2. Replicate this formula for all performances. 

Question 5  

In column J, a formula needs to be written to increase the cost of 

remaining tickets for a performance. The new ticket price is calculated by 

checking if sales are on target or the performance is on a Saturday. 
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1. Write a formula in cell J9, so that if a performance is on a 

Saturday OR is currently on target with sales, the price displayed should be 

the original ticket price + 10 UAH, otherwise the price should remain the 

same. 

2. Replicate this formula for all performances. 

Question 6  

In column K, a formula needs to be written to display the final sales 

price for any remaining tickets. The highest price should be the selling 

price. 

1. Write a formula in cell K9, so that if the ticket price in I9 is greater 

than J9, display the ticket price in I9, otherwise display the price in J9. 

2. Replicate this formula for all performances. 

 

The correct formulas:  

Q1   =IF(D9=14, "Matinee", "Evening") 

Q2 =IF(F9="Matinee", 80, 100) 

Q3  =IF(E9=$E$6,"Sold Out",IF(E9>=400,"On Target","Undersold")) 

Q4 =IF(AND(F9="Matinee", H9="Undersold"), G9-10, G9) 

Q5 =IF(OR(H9="On Target", C9="Saturday"), G9+10, G9) 

Q6 =IF(I9>J9,I9,J9) 

 

Tasks for laboratory work 

Task 5.3 

Create the Table 5.1.  

Calculate the following values:  

– Total World – total amount for the presented countries,  

– Average – the average value for the world,  

– Min – minimum value of the presented numbers,  

– Max– maximum value of the presented numbers,  

– Count – the number of listed countries;  

– % of Global – the percent producing by the country in total world 

amount 
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Table 5.1 – Initial data for Task 5.3. 

Natural Gas Oil 

Country 

Trillion 

Cubic 

Feet 

% of  

Global 
Country 

Trillion 

Cubic 

Feet 

% of  

Global 

Russia 21.1 
 

Saudi Arabia 4.1 
 

USA 18.2 
 

Russia 3.5 
 

Canada 6.5 
 

USA 2.5 
 

Algeria 3.1 
 

Iran 1.5 
 

UK 3.07 
 

Mexico 1.4 
 

Iran 55.1 
 

China 1.3 
 

Total World 
 

 

Total World 
 

 

Average 
 

Average 
 

Min 
 

Min 
 

Max 
 

Max 
 

Count 
 

Count 
 

 

Task 5.4 

Create the table presented in Figure 5.4.  

 

 

Figure 5.4 – The table for Task 5.4 

 

Complete the table according to the following questions: 

1. In cell C4 write a formula that will display ―pass‖ if the result in 

B4 is greater or equal to 5 and ―fail‖ if it is not. 

Replicate this formula to cells C5 to C8. 

2. In cell E4 write a formula that will display ―pass‖ if the result in 

B4 is greater or equal to the value in cell F1, and fail if it is not. 
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Replicate this formula to cells E5 to E8 

3. In cell F4 write a formula that will display ―improvement‖ if the 

result in D4 is greater than the result in B4, if not, display ―worst‖ 

Replicate this formula to cells F5 to F8 

4. In cell G4 write a formula that will display ―good‖ if score 1 and 

score 2 are greater than or equal to 8 and the total is17 or more. If it isn't, 

display ―poor‖. 

Replicate this formula to cells G5 to G8. 

Hint, this is an IF(AND.. formula: 

If(AND(first condition; second condition; third condition);"what to 

display if true"; "what to display if false"). 

Make sure that you have the same number of closing brackets as 

opening brackets. 

 

Task 5.5 

Create the table presented in Figure 5.5.  

 

 

Figure 5.5 – The table for Task 5.5 
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Complete the table according to the following questions: 

1. In cell C5 write a formula that will display the commission rate of 

the staff according to the second table. 

Replicate this formula to cells C6 to C8. 

 

Task 5.6 

Create the table presented in Figure 5.6.  

 

 
 

Figure 5.6 – The table for Task 5.6 

 

Complete the table according to the following questions: 

1. Insert a new column after ticket price. Give it the title, ―Agency 

Commission” 

2. In cell B14, enter 5% 

3. In cell G5, calculate the commission by multiplying the 'ticket 

price' by the 'commission rate'.  (This is an absolute reference. Replicate 

the formula to the other venues.) 

4. Change the 'commission rate' to 7%. What other columns does this 

affect? 

5. In cell K3 enter the title 'Book Venue' 

In cell K5, write a formula that will display 'book' if the profit is greater 

than 5,000.  If  not, then it should display 'cancel' 
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Task 5.7. Tasks for individual work 

Do the Tasks listed in Table 5.2. 

 

Table 5.2 – Tasks for creating and calculating tables in Excel 

№ Task description 

1 2 

1 

 

2 

 

The user enters a person's height and weight.

The RELATION column varies depending of the following:

If the weight is less than 70, then issue a rating of "NORMAL"

If more, depending of te growth. 

If growth is more than 180 then type "NORMAL"

otherwise type "Inconsistency between weight and height"

Height Weight Relation

170 75

181 75

The user enters the PC devices estimations (from 1 to 5)

Device
Device 

estimations 1

Device 

estimations 2

Device 

estimations 3

Processor 3 3 1

RAM (Random Access Memory) 3 3 1

HDD (Hard Disk Drive) 3 3 2

Video 2 2 2

System bus 2 4 2

Sum

Total score

The total score greater and equal to 15, and no estimate of "1"

then the final PC performance is "GOOD PC"

The total score less than 15, but more then 10

then the final PC performance is "MEDIUM PC"

The total sum is less than 10,

then the final PC performance is "LOW POWER PC"

Further, taking these estimations, the whole PC performance is 

determined according to the following rules:
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Continuation of the table 5.2 

1 2 

3 

 

4 

 

5 

 

The user enters two numbers (Number1 and Number2)

Then user enters the assumed average number of these two (Average)

If the input Average is correct, computer wrights "TRUE"

If the average number is more, then "NEED LESS"

If the average number is bigger, then "NEED MORE"

Number1 Number2
Assumed 

AVERAGE
Evaluation of PC

1 6 8 10 Need more

2 6 8 8 Need less

3 6 8 7 True

The car's fuel economy rating is given in the Table.

Provide the proper FUEL ECONOMY depending on the rating.

Calculate the cost of the fuel economy tax based on the list price of the car.

Title List Price Code Fuel Economy

Cost of 

fuel economy 

tax

Nissan Micra 6000 A

Ford Fusion 9000 B

Ford Fiesta 6000 A

Toyota Lexus 40000 C

Rating Fuel Economy Tax Rate

A Economical 0,05

B Medium 0,075

C Expensive 0,1

The sales per day  are given for each person. 

Estimate the Commission earned depending on the Comission rate

Employee
Sales per 

day

Commission 

earned
Hours per day The Comission rate

Sam 30 1 to 10 0,1

John 12 11 to 20 0,15

Anne 23 Over 20 0,2

Jess 9
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The end of the table 5.2 

1 2 

6 

 

7 

 

 

 

  

The working hours per 5-days week week are given for the employees. 

Estimate the salary coefficient depending on the Coefficient rate

Employee
Working hours

per week

Salary 

coefficient
Hours per day

The salary 

rate

Sam 40 1 to 4 0,5

John 30 5 to 7 0,75

Anne 32 Over 7 1

Jess 16

Provide the estimations of the student average scores

If s = 5 then "excellent"

If  4<= s <5 then "good"

If 3 <= s < 4 then "satisfactory"

If 2 <= s < 3 then "poor"

If s > 5 and s < 2 then "Invalid data"

Math Russian Informatics Physics

Semenov 5 5 5 5

Makarov 2 3 3 2

Ivanov 3 3 3 3

Petrov 4 4 4 4

Sidorov 1 1 1 1

Average 

score (s)
Estimations

Score for subject
Student
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Subject 6. SOLVING THE EQUATIONS USING  

THE SOLVER ADD-IN APPLICATION 

 

Task 6.1. Solve the quadratic equation: 
 

 

Solution. 

1. To estimate the number and approximate values of the equation 

roots, it is needed to build the graph of function 2( ) 5 6y x x x  on the 

range 1 5x . The data points for values are presented in 

Figure 6.1. 
 

 

Figure 6.1 – The data points for plotting the graph (Task 6.1) 

 

2. Approximately estimate the values, where ( ) 0y x . For this 

function the points are 
1 22; 3x x  (Figure 6.2). 

 

 

Figure 6.2 – The initial points of the roots 
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3. Excel will check if these two points are the equation’s roots or it 

will find the exact values. For the automatic solving firstly it is needed to 

prepare two cells A21 and B21: 

– A21 is the decision variable cell; 

here we type in the initial guess value ( ) of the equation’s root.  

– B21 is objective cell;  

type the formula  21^ 2 5* 21 6A A  

The number in B21 is the value of this function at (the value in 

cell A21).  

 

 
 

Figure 6.3 – Preparing the cells with initial variable and objective values 

 

4. Now it is needed to determine the value of A21 cell under which 

the function in cell B21 will be equal to 0 using Solver. 

On the Data tab, in the Analysis group, click Solver (Figure 6.4). 

 

 

Figure 6.4 – Preparing the cells with initial variable and objective values 

 

The Solver Parameters dialog box will appear. Set the following 

parameters (Figure 6.5): 

– The set objective – the absolute reference to the objective cell 

B21; 

– By changing variable cell – the absolute reference to the decision  

variable cell A21; 

– To – choose the value of equal to zero. 



63 

 

Figure 6.5 – The Solver Parameters dialog box 
 

– Select a solving method – choose GRG Nonlinear Solving Method 

as we have nonlinear function and press Options button. Change the values 

in the Options dialog box. And press OK button. The more detailed 

description of Options dialog box is given in Chapter 6.3. 

– You will return to the Solver Parameters dialog box. Press Solve 

button. The solver results window will appear (Figure 6.6c). Choose Keep 

solver Solution and press OK. 

– The results of the solving are presented in Figure 6.6. The Solver 

add-in found one root of the quadratic equation , which is 

in A21 cell and equal 
1 2.00000059x . 

5. The obtained result is only one of the equation’s roots.  

Do the same actions (step 4) for the cells A22 (typing ( )  as initial 

value) as decision variable cell and for the objective cell – cell B22. After 

solving you will get the result presented in Figure 6.6. The other root of the 
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quadratic equation , which is inA22 cell and equal 

2 2.99999917x . 

6. The answer: 

The quadratic equation   has two roots: 

1 2.00000059x  and 
2 2.99999917x . 

 

 

Figure 6.6 – The found values of equation roots 

 

Task 6.2. Tasks for laboratory and individual work 

Find the roots of the equations listed in Table 6.1. 
 

Table 6.1 – Variants for calculation 

№ Equation The range of variables 

1 2 3 

1 3 12 4 0x x  5 7x  

2 3 24 11 0x x  4 7x  

3 3 2 7 0x x  5 5x  

4 3 21 7 0x x  10 10x  



65 

The end of the table 6.1 

1 2 3 

5 3 51 1 0x x  10 10x  

6 3 23 14 1 0x x x  7 7x  

7 3 29 20 11 0x x x  3 4x  

8 3 12 5 0x x  3 4x  

9 3 27 17 0x x  3 10x  

10 3 26 6 7 0x x x  5 5x  

11 3 29 5 30 0x x x  5 10x  

12 3 23 2 0x x x  0 5x  

13 3 210 29 0x x  10 10x  

14 3 23 3 0x x  3 3x  

15 3 22 15 8 0x x x  3 3x  

16 3 23 4 1 0x x x  3 3x  

17 3 232 7 45 0x x x  5 5x  

18 3 25 2 7 0x x x  5 5x  

19 3 24 3 7 0x x x  5 5x  

20 3 22 6 3 0x x x  5 5x  

21 sin( ) 1 0x x  5 5x  

22 8cos( ) 6x x  5 5x  

 

6.3. Changing the Solver parameters 

To change Solver options that can affect the nature and accuracy of 

the solution, or the time Solver will spend seeking a solution, click Options 

in the Solver Parameters dialog. To clear all cell selections and reset all 

Solver options to their default values, click Reset All. 

Change Options for all Solving Methods (Figure 6.7): 
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Figure 6.7 – The All Methods tab in Solver Options dialog box 

 

1. Constraint precision /In the Constraint Precision box, type the 

degree of precision that you want. For a constraint to be considered 

satisfied, the relationship between the Cell Reference and the Constraint 

value cannot be violated by more than this amount. The smaller the 

number, the higher the precision. 

2. Use Automatic Scaling  /Select the Use Automatic Scaling check 

box to specify that Solver should internally rescale the values of variables, 

constraints and the objective to similar magnitudes, to reduce the impact of 

extremely large or small values on the accuracy of the solution process. 

3. Show Iteration Results /Select the Show Iteration Results check 

box to see the values of each trial solution. 
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4. Solving with Integer Constraints /Select the Ignore Integer 

Constraints check box to cause all integer, binary and all different 

constraints to be ignored when you next click Solve. /In the Integer 

Optimality % box, type the maximum percentage difference Solver should 

accept between the objective value of the best integer solution found and 

the best known bound on the true optimal objective value before stopping. 

5. Solving Limits.  

– In the Max Time (Seconds) box, type the number of seconds that 

you want to allow Solver to run. 

– In the Iterations box, type the maximum number of iterations that 

you want to allow Solver to perform.  

The following limits apply only to problems that include integer 

restrictions on variables, or problems that use the Evolutionary Solving 

Method: 

– In the Max Subproblems box, type the maximum number of 

subproblems that you want to allow. 

– In the Max Feasible Solutions box, type the maximum number of 

feasible solutions that you want to allow. For problems with integer 

restrictions, this is the maximum number of integer feasible solutions.  

To change Options for GRG Nonlinear Solving Method 

(Figure 6.8): 

1. Convergence. In the Convergence box, type the amount of 

relative change that you want to allow in the last five iterations before 

Solver stops with the message ―Solver converged to the current solution.‖ 

Smaller values here usually mean that Solver will take more time, but will 

stop at a point closer to the optimal solution. 

2. Derivatives. In the Derivatives group box, select Forward to 

estimate derivatives through forward differencing, or select Central to 

estimate derivatives through central differencing. Forward is the default 

choice. Central differencing yields more accurate derivatives, but requires 

twice as many calculations of the worksheet at each new trial solution. 

3. MultiStart Options for Global Optimization: 

a) Select the Use Multistart check box to use the multistart method 

for global optimization. If this box is selected when you click Solve, the 

GRG Nonlinear method will be run repeatedly, starting from different 



68 

(automatically chosen) starting values for the decision variables. This 

process may find a better solution, but it will take more computing time 

than a single run of the GRG Nonlinear method. 

 

 
 

Figure 6.8 – GRG Nonlinear Solving Method in Solver Options dialog box 
 

b) In the Population Size box, type the number of different starting 

points (values for the decision variables) you want the multistart method to 

consider. The minimum population size is 10; if you supply a value less 

than 10 in this box, or leave it blank, the multistart method uses a 

population size of 10 times the number of decision variables, but no more 

than 200. 

c) In the Random Seed box, type a positive integer number to be 

used as the (fixed) seed for the random number generator used to generate 

candidate starting points for the GRG Nonlinear method. If you enter a 

number here, the multistart method will use the same starting points each 
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time you click Solve. If you leave this box blank, the random number 

generator will use a different seed each time you click Solve, which may 

yield a different (better or worse) final solution. 

d)  Select the Require Bounds on Variables check box to specify 

that the multistart method should run only if you have defined lower and 

upper bounds on all decision variables in the Constraints list box. The 

multistart method is far more effective if you define bounds on all 

variables; the tighter the bounds on the variables that you can specify, the 

better the multistart method is likely to perform. 

Change Options for Evolutionary Solving Method(Figure 6.9): 

 

 

Figure 6.9 – Change Options for Evolutionary Solving Method 
 

1. Convergence. In the Convergence box, type the maximum 

percentage difference in objective values for the top 99% of the population 

that Solver should allow in order to stop with the message ―Solver 

converged to the current solution.‖ Smaller values here normally mean that 
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Solver will take more time, but will stop at a point closer to the optimal 

solution. 

2. Mutation Rate.  In the Mutation Rate box, type a number 

between 0 and 1, the relative frequency with which some member of the 

population will be altered or ―mutated‖ to create a new trial solution, 

during each ―generation‖ or subproblem considered by the Evolutionary 

method. A higher Mutation Rate increases the diversity of the population 

and the chance that a new, better solution will be found; but this may 

increase total solution time. 

3. Population Size.  In the Population Size box, type the number of 

different points (values for the decision variables) you want the 

Evolutionary method to maintain at any given time in its population of 

candidate solutions. The minimum population size is 10 members; if you 

supply a value less than 10 in this box, or leave it blank, the Evolutionary 

Solver uses a population size of 10 times the number of decision variables 

in the problem, but no more than 200. 

4. Random Seed. In the Random Seed box, type a positive integer 

number to be used as the (fixed) seed for the random number generator 

used for a variety of random choices in the Evolutionary method. If you 

enter a number here, the Evolutionary method will use the same choices 

each time you click Solve. If you leave this box blank, the random number 

generator will use a different seed each time you click Solve, which may 

yield a different (better or worse) final solution. 

5. Maximum Time without Improvement. In the Maximum Time 

without Improvement box, type the maximum number of seconds you want 

the Evolutionary method to continue without a meaningful improvement in 

the objective value of the best solution in the population, before it stops 

with the message ―Solver cannot improve the current solution.‖ 

6. Require Bounds on Variables. Select the Require Bounds on 

Variables check box to specify that the Evolutionary method should run 

only if you have defined lower and upper bounds on all decision variables 

in the Constraints list box. The Evolutionary method is far more effective if 

you define bounds on all variables; the tighter the bounds on the variables 

that you can specify, the better the Evolutionary method is likely to 

perform. 
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Subject 7. FINDING THE EXTREMES OF FUNCTION USING  

EXCEL SOLVER ADD-IN APPLICATION 
 

Task 7.1 

Find the minimum and maximum values of the following function  
 

2

2

1
,

1

x x
y

x x
 

In the range . 
 

Solution. 

1. Build the graph of  unction . 

In cells A2:A12 enter  values from to , take the increment  

. In cells B2:B12 enter the function  

, referencing to the cell with 

corresponding   value. Select the cells with values, then on the Insert tab, 

in Chart group select Scatter with Smooth Lines and Markers. The graph, 

presented in Figure 7.1 will appear. 
 

Figure 7.1 – The graph for Task 7.1 

 

2. Make the analysis of the graph.  

The obtained function on the investigated range has global minimum 

approximately at point  . It will be the initial value for finding the 

minimum value of the function. 
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To estimate the proper minimum value in point  the Solver 

add-in application can be used. 

3. Preparation of the cells for using Solver application (Figure 7.2). 

The cell A18will be the variable cell. Type the initial approximation 

in it  

The cell B18 will be the objective cell. Type here the equation with 

the observed function, with the reference to  value in A18 cell: 

. 

As the value inA18 is equal to 0.4, the value in B18 cell will be equal 

to 0.6129. 
 

 

Figure 7.2 – Initial values for finding minimum with Solver add-in application 

 

4. Using Solver for estimation of function’s minimal value. 

At this step it is needed to determine the value of A18 cell under 

which the function in cell B18 will take the minimal value. Use Solver 

add-in application. 

On the Data tab, in the Analysis group, click Solver. (Figure 7.3). 
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Figure 7.3 – Solver add-in application 

 

5. Configure the parameters of Solver. 

After selecting Solver, the Solver Parameters dialog box will appear. 

Set the following parameters (Figure 7.4): 

1) The set objective    – the absolute reference to the objective  

                                             cell B18; 

2) By changing variable cell   – the absolute reference to the decision   

                                              variable  cell A18; 

3) To      – choose the Min value. 

4) Add Subject to the Constraints. 
 

 
 

Figure 7.4 – The Solver Parameters dialog box 
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6. Add the constraints (Figure 7.5). 

In Task 7.1 the variable is changing on the range from 0 to 1, and the 

argument of the function should be limited by this range. So, we need to 

specify, that the value in variable cell should be greater or equal to 0 and 

less or equal to 1. 

To add the constrains press Add button in Solver Parameters dialog 

box. The Add Constrains dialog box will appear. Enter the following: 

1) Add the constraint, that (Figure 7.5a).  

In cell reference point the cell with  value. It is A18 cell.  

Select the proper sign―>=‖. In Constraint cell enter the value ―0‖. 

Then push Add button for adding the constraint. 

2) Add the constraint, that (Figure 7.5b).  

In cell reference point the cell with  value. It is A18 cell.  

Select the proper sign―<=‖. In Constraint cell enter the value ―1‖. 

Then push Add button for adding the constraint. 

 

a 

 

b 

 

Figure 7.5 – The Add Constrains dialog box 

 

7. The Solver Parameter dialog box will appear with the settled 

constrains, which are indicated in the box ―Subject of the Constraints‖ 

(Figure 7.6). 
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Figure 7.6 – The Solver Parameters dialog box with Subject of Constraints 
 

8. Select the solving method and specify its options. The Options 

dialog box will appear (Figure 7.7).After specifying the options press OK. 

The Solver Parameters dialog box will appear. Press Solve button. 
 

 

Figure 7.6 – The Solver Parameters dialog box with Subject of Constraints 
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9. The Solver Result dialog box will be on the screen. Choose ―Keep 

solver solution‖ and press OK button. 
 

 

Figure 7.7 – The Solver Results dialog box 

 

10. The solution will appear in the variable and objective cells 

(Figure 7.8). 
 

 

Figure 7.8 – The result of finding the minimum of function using Solver  
 

Answer: the function  on the 

range  has minimum in point . 
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Task 7.2 

Find the minimum and maximum values of the following function  
 

4 23 6 ,y x x  

In the range . 

 

Solution. 

1. Build the graph of function  on the range 

 (Figure 7.9). The increment was taken .  

 

 

Figure 7.9 – The graph for Task 7.2 
 

2. Make the analysis of the graph. 

The function on the given range has two local maximums and one 

local minimum.  The approximate points are: 

1
st
 maximum at  

2
nd

 maximum at  

minimum at  

It will be the initial value for finding the proper value. 

To estimate the proper minimum values, three points: -1
st
 

maximum;  – 2
nd

 maximum;  – minimum should be found 

using the Solver add-in application. 

Firstly, let’s find the 1
st
 maximum at . 



78 

3. Preparation of the cells for using Solver application (Figure 7.10). 

The cell A19will be the variable cell. Type the initial approximation 

in it  

The cell B19 will be the objective cell. Type here the equation with 

the observed function, with the reference to  value in A19 cell: 

. 

As the value inA19 is equal to 0.5, the value in B19 cell will be equal 

to 1.312. 

 

 

Figure 7.10 – Initial values for finding maximum with Solver add-in application 

 

4. Use Solver add-in application to estimate the exact value of the 

argument and function in maximum point. 

At this step it is needed to determine the value of A19 cell under 

which the function in cell B19 will take the maximal value. Use Solver 

add-in application. 

On the Data tab, in the Analysis group, click Solver. (Figure 7.3). 

5. Configure the parameters of Solver. 

After selecting Solver, the Solver Parameters dialog box will appear. 

Set the following parameters (Figure 7.11): 
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1) The set objective   – the absolute reference to the  

                                                        objective cell B19; 

2) By changing variable cell  – the absolute reference to the  

                                                        decision variable cell A19; 

3) To     – choose the Max value. 

4) Add Subject to the Constraints. 

 

Figure 7.11 – The Solver Parameters dialog box 
 

6. Add the constraints (Figure 7.12). 

In Task 7.2 the variable is changing on the range , and the 

argument of the function should be limited by this range. So, we need to 

specify, that the value in variable cell should be greater or equal to  and 

less or equal to . 

To add the constrains press Add button in Solver Parameters dialog 

box. The Add Constrains dialog box will appear. Enter the following: 

1) Add the constraint, that (Figure 7.12a).  

In cell reference point the cell with  value. It is A19 cell.  

Select the proper sign―>=‖. In Constraint cell enter the value ― ‖. 

Then push Add button for adding the constraint. 
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2) Add the constraint, that (Figure 7.12b).  

In cell reference point the cell with  value. It is A19 cell.  

Select the proper sign―<=‖. In Constraint cell enter the value ― ‖. 

Then push Add button for adding the constraint. 
 

a 

 
 

b 

 
 

Figure 7.12 – The Add Constrains dialog box 

 

7. The Solver Parameter dialog box will appear with the settled 

constrains, which are indicated in the box ―Subject of the Constraints‖ 

(Figure 7.13). 

 
 

Figure 7.13 – The Solver Parameters dialog box with constraints 
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8. Select the solving method and specify its options. The Options 

dialog box will appear (Figure 7.7). After specifying the options press OK. 

The Solver Parameters dialog box will appear. Press Solve button. 

9. The Solver Result dialog box will be on the screen. Choose ―Keep 

solver solution‖ and press OK button. 

10. The exact value of function local maximum point will appear 

in the variable and objective cells (Figure 7.14). 

 

 

Figure 7.14 – The 1
st
 maximum point obtained using Solver  

 

11. Find the 2
nd 

maximum at  by repeating the steps 3-10. 

The cell A20 use as the variable cell; the cell B20 use as the 

objective cell. The function and constraints are the same. 

12. Find the minimum at  by repeating the steps 3-10. 

The cell A21 use as the variable cell; the cell B21 use as the 

objective cell. The function and constraints are the same. 

13. The solution is presented in Figure 7.15. 
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Figure 7.15– The solution of Task 7.2 

 

Answer: the function  on the range  

has two local maximums in points  and  and one local 

minimum in point . 

 

Task 7.3. Tasks for laboratory and individual work 

Find local minimum and maximums of the functions listed in 

Table 7.1, column (2), on the given range, column (3). For drawing the 

graph of function use the increment presented in column (4). 
 

Table 7.1 - Variants for calculation 

№ Function 
The range of 

variables 
Increment 

1 2 3 4 

1 sin( )( ) 5 7x xF x x  1 15x  1h  

2 2cos( )( ) 2 0.5 5x xP x x  0 10x  0.5h  
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The end of the table 7.1 

1 2 3 4 

3 cos( )( ) 2 ex xW x x  5 5x  0.5h  

4 sin( )( ) 2 x xQ x x e  5 5x  0.5h  

5 2( ) 2 ln( ) 3cos(3 )Y x x x  1 5x  0.2h  

6 3( ) (cos( ) 0.5) ( cos( ))G x x x x  1 7x  0.5h  

7 
1

3( ) (4 7) 3cos( ) 4M x x x
 

1 10x  0.5h  

8 sin( )( ) 1 lg( ) xQ x x  1 10x  0.5h  

9 2 2( ) 1 ln( ) cos( )C x x x  1 10x  0.5h  

10 2 45 sin( )y x x  10 10x  1h  

11 2( ) 1 ( ) cos( )R x arctg x x  1 10x  1h  

12 2( ) 2 ln( ) sin( )K x x x  1 10x  1h  

13 cos( )( ) 1 lg( ) xL x x  1 10x  1h  

14 3 2( ) ln( ) sin( ) 10D x x x x  1 10x  1h  

15 lg( ) sin( )( ) ( 1) 5x xW x x e  2 15x  1h  

16 lg( ) 4( ) 0,5 cos( )xP x x e x  1 15x  1h  

17 3 2 2( ) ln( ) sin( ) ln( )Y x x x x  1 7x  0.5h  

18 3 3( ) sin( ) ( 2cos( ) )T x x x x  1 9x  0.5h  

19 3 2( ) lg( ) sin( ) lg( )Y x x x x  1 10x  0.5h  

20 
2cos( )( ) lg( ) sin( )xB x x x  

1 10x  0.5h  

21 5 2( ) ln( ) sin( ) 20Y x x x x  1 10x  0.5h  

22 
3 cos( )( ) sin( ) 0.3 5xZ x x x  1 8x  0.5h  

 



84 

Subject 8. SOLVING THE SET OF LINEAR EQUATIONS USING 

MICROSOFT EXCEL 
 

A system of linear equations is a collection of two or more linear 

equations involving the same set of variables. A general system of m linear 

equations with n unknowns can be written as 

 

 

11 1 12 2 1 1

21 1 22 2 2 2

1 1 2 2

n n

n n

m m mn n m

a x a x a x b

a x a x a x b

a x a x a x b

 (8.1) 

 

Or it can be represented as: 
 

 
1

n

ij j i

j

a x b  (8.2) 

 

where 1,2, ,i m  is the equation number, totally n; 

1,2, ,j n  is the number of variables in equations set, totally m; 

ija  is the matrix of coefficients in the left part of equations (the 

coefficients of the system); 

ib is the vector of right parts (the constant terms); 

jx  are unknowns. 

 

8.1. Matrix method 

Representing the system of linear equations in matrix form, we will get: 

 

 AX B , (8.3) 

where 

– matrix A containing ija  elements, which is the matrix of 

coefficients of the system; 

– matrix B containing
ib elements, which is the vector of the 

constant terms; 

– matrix X containing jx  elements, which are unknowns. 
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The system in matrix form is AX B . Matrix solution stands, that if 

the equation system is expressed in the matrix form, the entire solution set 

can also be expressed in matrix form. If the matrix A is square (has m rows 

and n=m columns) and has full rank (all m rows are independent), then the 

system has a unique solution given by 
 

 
1X A B . (8.4) 

 

where 1A  is the inverse of A . 

 

Task 8.1 

Find values  , which are the solution of the following system of 

linear equations: 

 

2 3 6

2 3 4 16

3 2 5 12

x y z

x y z

x y z

 

 

Solution 

1. Analysis of the set of linear equations to obtain matrix A 

containing ija  elements, which is the matrix of coefficients of the system 

and matrix B containing 
ib elements, which is the vector of the constant 

terms. 

The matrices A and B for Task 8.1 are presented in Table 8.1. 

 

Table 8.1 – The matrices A and B for Task 8.1 

The matrix of equation set 
The right parts 

   

    

    

    

 

2. Create the matrices with initial data in Excel 
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Enter the values of A matrix of equation set ( ija ) to the cells A4:C6 

(Figure 8.1) 

Enter B vector of right parts (
ib ) to cells G4:G6 (Figure 8.1) 

 

 
 

Figure 8.1– The matrices A and B for Task 8.1 in Excel 

 

3. Create the inverse matrix 1A  from Eq.(8.4) in Excel. 

To create the inverse matrix of initial data matrix, containing in cells 

A4:C6 do the following: 

1) Select the range A10:C12 then press button. 

2) Find the function MINVERSE and press OK button (Figure 8.2). 
 

 
 

Figure 8.2 – Insert Function dialog box with MINVERSE function 

 

3) The MINVERSE function arguments dialog box will open 

(Figure 8.3). 

4) Select A4:C6 cells as ARRAY(Figure 8.3). 
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Figure 8.3 – Insert Function dialog box with MINVERSE function 

 

5) Press instead OK button.  

! Don’t press OK button ! 

6) The inverse matrix 1A is obtained in A10:C12 cells (Figure 8.4). 
 

 

Figure 8.4 – The inverse matrix in cells A10:C12 
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4. Get the solution vector X containing jx  elements, which are 

unknowns. 

To obtain the vector with unknowns in Excel do the following: 

1) Select the range F10:F12, where the results will be placed, then 

press  button. 

2) Find the function MMULT and press OK button. 

3) The MMULT function arguments dialog box will open (Figure 

8.5). 

4) Select A10:C12 cells as Array1 and G4:G6 cells as Array2 

(Figure 8.5). 

 

Figure 8.5 – MMULT function arguments dialog box 

 

5) Press instead OK button.  

! Don’t press OK button ! 
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6) The solution vector X is obtained in F10:F12cells (Figure 8.6). 

 

 

Figure 8.6 – The obtained solution for Task 8.1 

 

Answer: the solution of equation set from Task 8.1 is: ; ; . 

 

8.2. Solving the system of linear equations according to Cramer's 

rule 

Consider a system of n linear equations for n unknowns, represented 

in matrix multiplication form as follows: 

 

 Ax b  (8.5) 

 

where the n × n matrix A has a nonzero determinant; 

the vector 
1 2, , ,

T

nx x x x   is the column vector of the variables.  

Then the theorem states that in this case the system has a unique 

solution, whose individual values for the unknowns are given by: 

 

 
det

det

i

i

A
x

A
 , 1,2, ,i n  (8.6) 

 

Where  is the matrix formed by replacing the i-th column of A by 

the column vector b. 
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Task 8.2 

Find values , which are the solution of the following system of 

linear equations: 

2 3 6

2 3 4 16

3 2 5 12

x y z

x y z

x y z

 

 

Solution 

1. Analysis of the set of linear equations to obtain matrix A 

containing ija  elements, which is the matrix of coefficients of the system 

and matrix B containing 
ib elements, which is the vector of the constant 

terms. 

The matrices A and B for Task 8.2 are the same as for Task 8.1 and 

are presented in Table 8.1. 

2. Create the matrices with initial data in Excel 

Enter the values of A matrix of equation set ( ija ) to the cells A4:C6 

(Figure 8.1) 

Enter B vector of right parts (
ib ) to cells G4:G6 (Figure 8.1) 

3. Estimate the main determinant det A . 

To estimate the main determinant of the equation set, it is needed to 

create the matrix A with the values from the matrix, containing ija  

elements, which is the matrix of coefficients of the system. Then find its 

determinant doing the following: 

1) Copy the cells from the range A4:C6 to the range A10:C12 then 

select C13 cell and press   button. 

2) Find the function MDETERM and press OK button. 

3) The MDETERM function arguments dialog box will open. 

4) Select A10:C12 cells as ARRAY (Figure 8.7a). 

5) Press OK button. 

6) In cell C13 the result presented in Figure 8.7b is obtained. 

4. The estimation of additional determinants for X, Y, Z 
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1) Enter the matrix to estimate the additional determinant 

 in range A16:C18 (Figure 8.8).Using the function 

MDETERM find the value of  in C19 cell (Figure 8.8). 

2) Enter the matrix for additional determinant  

estimation in range E16:G18. Using the function MDETERM find the 

value of  in G19 cell (Figure 8.8). 

3) Enter the matrix for additional determinant   

estimation in range J16:L18. Using the function MDETERM find the 

value of   in L19 cell (Figure 8.8). 

 

a 

 

b 

 

Figure 8.7 – The estimation of main determinant 
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Figure 8.8 – The estimation of additional determinant 

 

5. Get the solution vector X containing jx  elements, which are 

unknowns according to Eq.(8.6). 

To obtain the vector with unknowns in Excel do the following: 

1) In cell B22 find the  value ( 1det detx A A ), for this in B22 

enter    

― ‖. 

2) In cell B23 find the  value( 2det dety A A ), for this in B23 

enter   ― 

‖. 

3) In cell B24 find the  value( 3det detz A A ), for this in B24 

enter     

― ‖. 

4) The solution vector X is obtained in B22:B24cells (Figure 8.9). 
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Figure 8.9 – The obtained solution for Task 8.2 

 

Answer: the solution of equation set from Task 8.2 is: ; ; . 

 

8.3. Solving the system of equations set using SOLVER add-in 

application 

To find the solution of linear equation set in form given in Eq.(8.1) 

using SOLVER add-in application it is needed to get the full function of 

equations in the following form: 

 

 

1 2

2

1 11 2 12 1 1

2

2 21 2 22 2 2

2

1 2

( , , , )n

n m

n m

n n n n n nm n

F x x x

x a x a x a b

x a x a x a b

x a x a x a b

 (8.7) 

 

Then using SOLVER add-in application it is possible to find the 

solution of Eq.(8.7) with  unknowns. 
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Task 8.3 

Find values , which are the solution of the following system of 

linear equations: 

 

2 3 6

2 3 4 16

3 2 5 12

x y z

x y z

x y z

 

 

Solution 

1. Analysis of the set of linear equations to represent the linear 

equation set in the form of Eq.(8.7). 

The equation set from Task 8.3 can be represented as following 

function: 
2 2 2

( , , ) 2 3 6 2 3 4 16 3 2 5 12F x y z x y z x y z x y z  

2. Prepare the cells for SOLVER. 

1) Enter the first guessed values of variables . 

For Task 8.3 the initial guessed values can be taken as 

).  

Enter 1 in cell A5, B5 and C5. 

2) Enter the function to cell E5, selecting the references to 

the cellsA5, B5, C5 with values: 
 

 

 
 

3. In Data ribbon find SOLVER add-in (Figure 8.10). 

1) The set objective   – the absolute reference to the 

                                                        objective cell E5 cell ($E$5); 

2) By changing variable cell  – the absolute reference to the 

                                                        decision variable cells A5:C5; 

3) To     – select ― ‖to find the root of the 

                                                        function . 

4. In cells A5, B5 and C5will appear the solution presented in Figure 

8.11. 
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Figure 8.10 – The Solver Parameters dialog box for Task 8.3 

 

 
 

Figure 8.11 – The obtained solution for Task 8.3 

 

Answer: the solution of equation set from Task 8.3 is: ; ; . 

 

Task 8.4. Tasks for laboratory and individual work 

Solve the sets of equations listed in Table 8.2 using the approaches 

observed above. 

 

Table 8.2 – Tasks for calculation 

№ Set of Equations 

1 2 

1 

0.85 0.05 0.08 0.14 0.48

0.32 1.43 0.12 0.11 1.24

0.17 0.06 1.08 0.12 1.15

0.21 0.16 0.36 0.88

x y z t

x y z t

x y z t

x y z t
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The end of the table 8.2 

1 2 

2 

0.28 0.17 0.06 0.21

0.52 0.12 0.17 1.17

0.17 0.18 0.79 0.81

0.11 0.22 0.03 0.95 0.72

x y z t

x y z t

x y z

x y z t

 

3 

2.5 4 7 12.115

3 0.87

7 2 1.5 35.93

x y z

x y z

x y z

 

4 

7 20 91.65

4 5 2 14.85

10 2 15 87.2

x y z

x y z

x y z

 

5 

2 15 8 206.45

12 7 3 39.06

7 2 12 148.14

x y z

x y z

x y z

 

6 

6.05 0.13 8.57 19.6

15.46 8 13.94 23.8

7.18 12.6 0.07 0.04

x y z

x y z

x y z

 

7 

2 3 5 1

3 13 22 1

3 5 2 5

2 3 4 7 4

x y z t

x y z t

x y z t

x y z t

 

8 

1 2 3 4

1 2 3 4

1 2 3 4

1 2 3 4

0.87 0.27 0.22 1.28 1.21

0.21 0.3 0.45 0.18 0.33

0.12 0.13 1.33 0.18 0.48

0.33 0.05 0.06 1.28 0.17

x x x x

x x x x

x x x x

x x x x

 

9 

103

295

3142

321

321

321

xxx

xxx

xxx

 

 



97 

Subject 9. ADDING THE TREND LINES 

 

9.1. Trend lines in Excel 

Trend line is a graphic representation of trends in data series, such 

as a line sloping upward to represent increased sales over a period of 

months. Trend lines are used for the study of problems of prediction, also 

called regression analysis. 

By using regression analysis, it is possible to extend a trend line in a 

chart beyond the actual data to predict future values.  

R-squared value. A number from 0 to 1 that reveals how closely the 

estimated values for the trend line correspond to the actual data. A trend 

line is most reliable when its R-squared value is at or near 1. R-squared 

value is also known as the coefficient of determination. 

Microsoft Office Excel provides six different trend or regression 

types: linear trend lines, logarithmic trend lines, polynomial trend lines, 

power trend lines, exponential trend lines, or moving average trend lines.  

The type of data that is needed to determine depends on the type of 

trend line, which is used. The standard approximation functions are listed 

in Table 9.1. 

 

Table 9.1 – Standard functions used for approximations 

Name Example of graph Equation 

1 2 3 
Power 

function 

 

 

Exponential 
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The end of the table 9.1 

1 2 3 
Linear 

 

 

Logarithmic 

 

 

Polynomial 

 

 

Moving 

average 

 

 

 

Task 9.1 

Use the following data for solution concentration C, [%] in paint 

from the temperature depression, [°C]: 

Solution  

concentration,  % 

10 20 30 35 40 45 50 55 60 70 

Temperature  

depression,  °C 

1.5 4.5 10.5 14.3 19 24.3 30 36.5 43 60 
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It is needed to find the functional dependence of temperature 

depression from solution concentration, select the curve type and estimate 

the functional dependence number.  
 

Solution. 

1. Enter the table with initial data and plot the corresponding graph 

(Figure 9.1). 
 

 

Figure 9.1 – The initial data and graph for Task 9.1 

 

2. Add the trend line to the graph. 

1) Press the right mouse button and in the appeared menu select 

―Add Trend line…‖ (Figure 9.2). 
 

 

Figure 9.2 – Adding trend line to the graph 
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2) Select the first regression type in the Format Trend line dialog 

box.  

For the data presented in Figure 9.1 the power regression can be in 

good agreement. 

Select the Power regression type, mark the ―Display Equation on 

chart‖ and ―Display R-squared value on chart‖ (Figure 9.3). 
 

 

Figure 9.3 – Changing parameters in Format Trend line dialog box 
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3) The trend line, its function and R-squared value will appear on the 

graph (Figure 9.4). 
 

 
 

Figure 9.4 – Power regression for Task 9.1 
 

4) Select the other regression type. 

Plot the other graph for the data from Task 9.1 and add the trend line 

with exponential type of regression. The obtained trend line, its function 

and R-squared value are presented in Figure 9.5. 

 

Figure 9.5 – Exponential regression for Task 9.1 
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3. Select the best approximation function comparing R-squared 

value. 

For power regression the R-squared value is equal to , 

and for exponential regression . The value for the power 

regression is closer to 1, and is better. 

 

Answer: the approximation function for data from Task 8.3 is:  

; 

The R-squared value is equal to . 

 

Task 9.2 

Using Table 9.2 find the functional dependence of specific heat 

capacity from the temperature. The temperature T, [°C] is given in the table 

heading. The specific heat capacity data are listed for the substances 

according to the variant. For example, variant 2 contains the data for 

acetone. 

 

Table 9.2 – Data foe task 9.2 

№ Substance 

Specific heat capacity at the temperature,  

°C (in kJ/(kg·°C)) 

-20 0 20 40 60 80 100 

1 Ammonia (liquid) 4.522 4.606 4.731 4.857 5.108 5.443 5.736 

2 Acetone 2.052 2.114 2.177 2.24 2.303 2.37 2.445 

3 Dichloroethane 0.971 1.057 1.147 1.23 1.327 1.419 1.512 

4 CaCl2 (25%) 2.818 2.889 2.939 2.973 3.057 3.098 3.14 

5 Methanol 2.382 2.466 2.567 2.667 2.763 2.864 2.964 

6 H2SO4 (75%) 1.805 1.872 1.939 2.006 2.073 2.145 2.207 

7 Toluene 1.52 1.612 1.704 1.796 1.888 1.98 2.068 

8 Chlorine benzene 1.193 1.256 1.319 1.382 1.445 1.507 1.574 

9 CCl4 0.812 0.837 0.863 0.892 0.921 0.946 0.975 
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